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Overview
Hex FileView is a Windows program which allows you to view any file in a hexadecimal and 
ANSI/ASCII character format.    Files up to one gigabyte in length can be viewed.    
Operations possible with the currently loaded file include comparing, searching, printing 
and changing file contents.    File attributes, file dates and file times can also be changed on
multiple files at once.

Special files:
Sound files (WAV & MID) can be played if you have the appropriate sound drivers.    Picture 
files (BMP, ICO & WMF) can be viewed as pictures.    The files contained in archive files (ZIP 
& ARC) can be listed.

Fonts:
All loaded fonts can be viewed with the included program FontView which is accessible 
from within Hex FileView.

General usage:
Hex FileView is helpful in identifing files when doing system housekeeping and anytime a 
files internal structure needs to be examined.    Most files internally have clues to their 
source, examples are copyright notices and header information for database files showing 
field names and sizes.    With Hex FileView you can view any file to help determine what 
program it belongs to and its purpose.



File Menu
Load File:    With this selection you load the file you wish to view.

Search for String:    Use this selection if you want to search for a certain string of characters
or hexadecimal values within the currently viewed file.

Write to File:    This selection is used to write a string of characters or hexadecimal values to
the currently viewed file.    WARNING: Make back up copies of files before using this 
selection.    Do not make changes to any file (especially .EXE or .COM files) unless you are 
absolutely sure of what the result will be.

File Compare:    To determine if a file is identical to the currently viewed file use this option.  
If the files are not equal the program will allow you to display both files where the 
miscompare was found.

Print File:    Use this selection to print the currently viewed file or a selected range of it.

Exit:    This selection quits the program.



Disk Menu
Show Disk Info:    This selection shows information about the disk that you select.    The 
information includes;    Volume Label, Total bytes & Free bytes.



Options Menu
Copy File:    Copies a specified file.

Delete File:    Deletes a specified file.

Change File Attributes:    Used to change file attributes, file dates and file times.

View Picture:    Used to view a currently loaded picture file (BMP, ICO or WMF) as a picture.

Play Sound:    Used to play a currently loaded sound file (WAV or MID).

Show ARC/ZIP Contents:    Lists the files contained in a currently loaded archive file (ARC or 
ZIP). 

Font Viewer:    Runs the FontView program which allows you to view any of your loaded 
fonts.    For more information about FontView please view its help file.

Environment Options:    This selection allows you to change display fonts and colors.

Show System Info:    Displays system information such as version of DOS and Windows 
running on your system, processor type and mode.



Help Menu
Contents:    Displays the contents of this help file.

Search for Help on:    Allows you to search for help on a topic.

Help on Help:    Displays the Windows Help on Help file.

Code Reference:    Runs the code reference program which displays information about the 
ANSI and ASCII character sets and common file extensions.    For more information about 
the Code Reference program please view its help file.

Registration Info:    Displays information about registering Hex FileView.

About:    Displays copyright and version information.



Registration
This program is a Shareware product.    You may copy this program and distribute it to your 
friends for their evaluation.    If you make use of this software you are expected to pay a 
registration fee.    Please help support the Shareware concept by registering your Shareware
programs.    This will enable shareware authors to continue to write new programs.

Each registered user of this program may install this program on as many computers as 
they like as long as its not used at more than one location at the same time.    (See the 
order form for multiple user site licenses).    When you register this program you will receive
a letter confirming your registration that will include a code to remove the message 
"Unregistered Shareware" from the title bar.    E-mail and regular mail support will be free to
registered users for one year.    Free upgrades will be made available to registered users 
when the upgrades fix bugs that effect functionality, for a full year after registration.    If a 
registered user has a problem with this program that effects functionality that we cannot 
correct, then a full refund of the registration fee will be offered.    To register please print 
and fill out the ORDER.DOC file, which can be printed from the Registration Info selection of
the Help menu.



Definition of Shareware
The following definition of Shareware is an excerpt from a file on Shareware provided by the
Association of Shareware Professionals, prepared by Paul Mayer, author of GRAB Plus.

Shareware distribution gives users a chance to try software before buying it. If you try a 
Shareware program and continue using it, you are expected to register.    Individual 
programs differ on details -- some request registration while others require it, some specify 
a maximum trial period.    With registration, you get anything from the simple right to 
continue to using the software to an updated program with printed manual.

Copyright laws apply to both Shareware and commercial software, and the 
copyright holder retains all rights, with a few specific exceptions as stated in the license 
agreement.    Shareware authors are accomplished programmers, just like commercial 
authors, and the programs are of comparable quality.    (In both cases, there are good 
programs and bad ones!)    The main difference is the method of distribution.    The author 
specifically grants the right to copy and distribute the software, either to all and sundry or 
to a specific group.    For example, some authors require written permission before a 
commercial disk vendor may copy their Shareware.

Shareware is a distribution method, not a type of software.    You should find 
software that suits your needs and pocketbook, whether its commercial or Shareware.    The
Shareware system makes fitting your needs easier, because the overhead is low, prices are
low also.    Shareware has the ultimate money-back guarantee -- if you don't use the 
product, you don't pay for it.



Disclaimer of Warranty
THIS SOFTWARE AND MANUAL ARE SOLD "AS IS" AND WITHOUT WARRANTIES AS TO 
PERFORMANCE OF MERCHANTABILITY OR ANY OTHER WARRANTIES WHETHER EXPRESSED 
OR IMPLIED.    BECAUSE OF THE VARIOUS HARDWARE AND SOFTWARE ENVIRONMENTS 
INTO WHICH THIS PROGRAM MAY BE PUT, NO WARRANTY OF FITNESS FOR A PARTICULAR 
PURPOSE IS OFFERED.    GOOD DATA PROCESSING PROCEDURE DICTATES THAT ANY 
PROGRAM BE THOROUGHLY TESTED WITH NON-CRITICAL DATA BEFORE RELYING ON IT.    
THE USER MUST ASSUME THE ENTIRE RISK OF USING THE PROGRAM.    ANY LIABILITY OF 
THE SELLER WILL BE LIMITED EXCLUSIVELY TO PRODUCT REPLACEMENT OR REFUND OF 
PURCHASE PRICE.



License Agreement
You may try this program for one months time before either having to register it or stop 
using it.    Feel free to share this program with anyone, but please do not give it away 
altered or as part of another system.    If you continue to use this program and register it 
you may not share the registration code with anyone.    You may use this program on as 
many computers as you wish as long as only one copy of it is being used at any one time.    
Your registration is not transferrable.    This agreement shall be governed by the laws of the 
State of Minnesota.    Any legal action or proceeding initiated by either party originating 
from or relating to this agreement shall be brought about only in a State or Federal Court of
competent jurisdiction located in Hennepin county, Minnesota.    The parties hereby agree 
to the jurisdiction of said courts.    If you do not agree with this license agreement, then do 
not use the program and do not register it.



ASP Ombudsman Statement
Specific Applications Software is a member of the Association of Shareware Professionals 
(ASP).    ASP wants to make sure that the shareware principle works for you.    If you are 
unable to resolve a shareware-related problem with an ASP member by contacting the 
member directly, ASP may be able to help.    The ASP Ombudsman can help you resolve a 
dispute or problem with an ASP member, but does not provide technical support for 
members' products.    Please write to the ASP Ombudsman at 545 Grover Road, Muskegon, 
MI 49442 or send a CompuServe message via CompuServe Mail to ASP Ombudsman 
70007,3536.



ANSI
American National Standards Institute.



ASCII
American Standard Code for Information Interchange.



Change File Attributes
This selection of the Options Menu is used to change a file(s) date & time and/or a file(s) 
attributes (The four file attributes are System, Hidden, Read Only and Archive).

To change file attributes:

1 - Select the file or files that you want to change attributes for from the File List by double 
clicking on the file name(s).    The file(s) will then appear in the    Selected Files list.    (Note: 
the file date, time and attributes are displayed for the highlighted file name in the Selected 
Files list.)

2 - Change the attribute check boxes to the desired values.

3 - Click the Set Attributes button.    After clicking the button all the Selected Files will have 
their attributes set as you indicated in step 2.

To change file date & time:

1 - Select the file or files that you want to change file date & time for from the File List by 
double clicking on the file name(s).    The file(s) will then appear in the    Selected Files list.    
(Note: the file date, time and attributes are displayed for the highlighted file name in the 
Selected Files list.)

2 - Change the file date and time to the desired values in the text boxes in the following 
format: date = mm/dd/yy    time = hh:mm AM or hh:mm PM

3 - Click the Set "Date - Time" button.    After clicking the button all the Selected Files will 
have their dates & times set as you indicated in step 2.



Play Sound
This selection of the Options Menu is used to play a sound file.    Sound files have one of the
following file name extensions: .WAV or .MID.

After selecting Play Sound the file will begin playing and the Play Sound window will appear.
Controls on this form allow you to stop, pause, rewind and play.

Note: to use this feature you must have the proper sound drivers and hardware that 
support playing sound files.    



Environment Options
This selection of the Options menu is used to set the programs file viewer display colors 
and font.

Titles, text and background colors can be set by clicking on the appropriate button and 
selecting the your choice of color.

Fonts may be set to either an ANSI character font or the ASCII font.    Only one ASCII font is 
available which will be displayed immediately after clicking the ASCII Font button.    The 
number of ANSI fonts available for use in this program is determined by the number of ANSI
fixed pitch fonts you have loaded on your system.

The environment settings you choose can be automatically used every time you run this 
program by checking the "Save Environment Settings on Exit" box.

When you make a change to the colors or font selection, the changes are shown in the 
Preview window.    After you have finished making your selections then click the Ok button 
to continue, or press Cancel to return the font and colors to their original settings.



Comments
Please!    Please!    Please!    Send me your comments by postcard or E-mail.    This is the first
released version of this program and I need your help to improve it.    My CompuServe ID is 
76470,3424    from the Internet this would be 6470.3424@compuserve.com or send a 
postcard to Tim Carlson, Specific Applications Software, P.O. 6146, Minneapolis, MN 55406-
0146.



Support
Registered users of this program receive free mail or E-mail support for one year.    Contact 
the author at one of the addresses that follow.    CompuServe ID 76470,3424    from the 
Internet this would be 6470.3424@compuserve.com or send a postcard to Tim Carlson, 
Specific Applications Software, P.O. 6146, Minneapolis, MN 55406-0146.




